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Safety Instructions

Safety Instructions ¢ English

& WARNING: This symbol, A, when used on the product, is intended to
alert the user of the presence of uninsulated dangerous voltage within
the product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, &, when used on the product, is intended
to alert the user of important operating and maintenance (servicing)
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF
compatibility, accessibility, and related topics, see the Extron Safety and
Regulatory Compliance Guide, part number 68-290-01, on the Extron website,
www.extron.com.
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Sicherheitsanweisungen ¢ Deutsch

WARUNG: Dieses Symbol A\ auf demProdukt soll den Benutzer darauf
aufmerksam machen, dass im Inneren des Geh&uses dieses Produktes
gefahrliche Spannungen herrschen, die nicht isoliert sind und die einen
elektrischen Schlag verursachen kénnen.

VORSICHT: Dieses Symbol A\ auf dem Produkt soll dem Benutzer in
der im Lieferumfang enthaltenen Dokumentation besonders wichtige
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen Uiber die Sicherheitsrichtlinien, Produkthandhabung,
EMI/EMF-Kompatibilitat, Zuganglichkeit und verwandte Themen finden Sie in den
Extron-Richtlinien fir Sicherheit und Handhabung (Artikelnummer

68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad ¢ Espaiol

ADVERTENCIA: Este simbolo, &, cuando se utiliza en el producto, avisa
al usuario de la presencia de voltaje peligroso sin aislar dentro del
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCION: Este simbolo, &, cuando se utiliza en el producto,
avisa al usuario de la presencia de importantes instrucciones de
uso y mantenimiento estas estan incluidas en la documentacion
proporcionada con el equipo.

Para obtener informacién sobre directrices de seguridad, cumplimiento

de normativas, compatibilidad electromagnética, accesibilidad y temas
relacionados, consulte la Guia de cumplimiento de normativas y seguridad de
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Instructions de sécurité ¢ Francais

AVERTISSEMENT : Ce pictogramme, A\, lorsqu’il est utilisé sur le
produit, signale a I'utilisateur la présence a I'intérieur du boitier du
produit d’une tension électrique dangereuse susceptible de provoquer
un choc électrique.

ATTENTION : Ce pictogramme, &, lorsqu’il est utilisé sur le produit,
signale a I'utilisateur des instructions d’utilisation ou de maintenance
importantes qui se trouvent dans la documentation fournie avec
I’équipement.

Pour en savoir plus sur les régles de sécurité, la conformité a la réglementation,
la compatibilité EMI/EMF, I'accessibilité, et autres sujets connexes, lisez les
informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site
Extron, www.extron.com.

Istruzioni di sicurezza e Italiano

AVVERTENZA: Il simbolo, &, se usato sul prodotto, serve ad avvertire
'utente della presenza di tensione non isolata pericolosa all’interno
del contenitore del prodotto che puo costituire un rischio di scosse
elettriche.

ATTENTZIONE: Il simbolo, &, se usato sul prodotto, serve ad avvertire
I'utente della presenza di importanti istruzioni di funzionamento e
manutenzione nella documentazione fornita con I’'apparecchio.

Per informazioni su parametri di sicurezza, conformita alle normative,
compatibilita EMI/EMF, accessibilita e argomenti simili, fare riferimento alla Guida
alla conformita normativa e di sicurezza di Extron, cod. articolo 68-290-01, sul
sito web di Extron, www.extron.com.

Instrukcje bezpieczenstwa ¢ Polska

OSTRZEZENIE: Ten symbol, é’il, gdy uzywany na produkt, ma na celu
poinformowacé uzytkownika o obecnosci izolowanego i niebezpiecznego
napiecia wewnatrz obudowy produktu, ktéry moze stanowi¢ zagrozenie
porazenia prgdem elektrycznym.

UWAGI: Ten symbol, &, gdy uzywany na produkt, jest przeznaczony do
ostrzegania uzytkownika wazne operacyjne oraz instrukcje konserwaciji
(obstugi) w literaturze, wyposazone w sprzet.

Informaciji na temat wytycznych w sprawie bezpieczenstwa, regulacji wzajemnej
zgodnosci, zgodnos¢ EMI/EMF, dostepnosci i Tematy pokrewne, zobacz Extron
bezpieczenstwa i regulacyjnego zgodnosci przewodnik, cze$é numer 68-290-01,
na stronie internetowej Extron, www.extron.com.

UHCTPYKUMa No TexHuke 6e3onacHocTu ¢ Pycckuii

NPEAYNPEXAOEHUE: [anHbiii cumBon, A, ecnn ykasaH
Ha NPOAYKTe, NpeaynpexaaeT Nofib3oBaTens 0 Hann4umn
HEN30/IMPOBAHHOIO OMACHOIr0 HamnpPsXeHUs BHYTPU Koprnyca
NPOoAyKTa, KOTOPOE MOXET NPUBECTU K NMOPAXKEHUIO
3M1eKTPUYECKMM TOKOM.

BHUMAHME: [aHHbili cumBon, A\, ecnn yKkasaH Ha npoaykTe,
npegynpexaaeT Nonb30BaTesNs O HANMNYUN BaXHBIX MHCTPYKLUMIA Mo
aKkcnayaTaumm n 06CNyX1MBaHuio B PyKOBOACTBE, NpuiaraeMoM K
JaHHOMy 060pya0BaHMIO.

Ana nonydyeHuns nHbopmaLmm o npaBunax TexHUkn 6e3onacHocTu,
cobniofeHn HOpMaTUBHBIX TPEBOBaHUI, SNEKTPOMArHUTHON
coBmecTumocTn (OMIM/34C), BO3MOXHOCTM A0CTyna 1 Apyrnx Bonpocax
CM. PYKOBOACTBO MO 6€30nacHOCTU 1 COBMI0AEHNIO HOPMATUBHBIX
TpeboBaHuin Extron Ha calite Extron: , www.extron.com,

HOMep no kartanory - 68-290-01.
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All trademarks mentioned in this guide are the properties of their respective owners.
The following registered trademarks®, registered service marks(®"), and trademarks(™) are the property of RGB Systems, Inc. or Extron (see the

current list of trademarks on the Terms of Use page at www.extron.com):
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Global Configurator, Global Scripter, GlobalViewer, Hideaway, HyperLane, IP Intercom, IP Link, Key Minder, LinkLicense, Locklt, MediaLink,
MediaPort, NAV, NetPA, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, ShareLink, Show Me, SoundField, SpeedMount, SpeedSwitch,
StudioStation, System INTEGRATOR, TeamWork, TouchLink, V-Lock, VN-Matrix, VoiceLift, WallVault, WindoWall, XPA, XTP, XTP Systems, and

Registered Service Mark® : S3 Service Support Solutions

Trademarks (™

AAP, AFL (Accu-RATE Frame Lock), ADSP (Advanced Digital Sync Processing), AVEdge, CableCover, CDRS (Class D Ripple Suppression),
Codec Connect, DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP
(Digital Sync Validation Processing), EQIP, Everlast, FastBite, Flex55, FOX, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, Opti-Torque,
PendantConnect, ProDSP, QS-FPC (QuickSwitch Front Panel Controller), Room Agent, Scope-Trigger, SIS, Simple Instruction Set, Skew-Free,
SpeedNay, Triple-Action Switching, TruedK, True8K, Vector™ 4K, WebShare, XTRA, and ZipCaddy
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FCC Class B Notice

NOTE: This device complies with part 15 of the FCC rules. Operation is subject to
the following two conditions: (1) This device may not cause harmful interference,
and (2) This device must accept any interference received, including interference
that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC rules. These limits provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. There is no
guarantee that interference will not occur. If this equipment does cause interference to
radio or television reception, which can be determined by turning the equipment off and
on, you are encouraged to try to correct the interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

«  Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with
this equipment. Operation with non-approved equipment or unshielded cables is likely to
result in interference to radio and TV reception. The user is cautioned that changes and
modifications made to the equipment without the approval of the manufacturer could void
the user’s authority to operate this equipment.

NOTE: For more information on safety guidelines, regulatory compliances, EMI/EMF
compatibility, accessibility, and related topics see the Extron Safety and Regulatory
Compliance Guide on the Extron website.




Conventions Used in this Guide

In this user guide, the following are used:

Notifications

DANGER:
e Will result in serious injury or death.

e Entrainera des blessures graves ou la mort.

ATTENTION:
e Risk of property damage.
e Risque de dommages matériels.

| NOTE: A note draws attention to important information.

Specifications Availability

Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at www.extron.com/technology/glossary.aspx.
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Introduction

This section provides an overview of the Extron Certified DSP Bundle for Zoom Rooms —
Extra Large Room. Topics include:

* About this Guide
 Overview
« Requirements

+ Application Diagrams

« Installation Details

About this Guide

This guide describes the integration of the Extron Certified DSP Bundle for Zoom® Rooms
- Extra Large Room system.

Overview

Requirements

Zoom and Extron have come together to provide Zoom Rooms solutions with our
certified hardware. Now it is easier than ever to stay connected with flexibility of realtime
collaboration from anywhere. The products in our Zoom Rooms Certified Design Solutions
have been designed and meticulously tested for best-in-class performance and ease of

use.

Extron Equipment List

Product Description Quantity
DMP 128 Plus C V AT | 12x8 Digital Matrix Processor w/ AEC, VoIP, & 1
Dante
XPA U 1004 SB Four-Channel Bridgeable Output Ampilifier 1
SF 3CT LP 3" Full-Range Ceiling Speakers, 70/100V, Pair 3
SPK14P 14 AWG Plenum Speaker Cable - 150' (45.7 m) 1
USB CFG Cable USB A Male to USB Mini B Male 6' (1.8 m) 1
Audio Cable Balanced audio cable for Audio DSP output to 1
Amplifier Input - 6' (1.8 m)
Network Cable Cat-6 Plenum network cable - 50' (15.2 m) 2
Network Cable Cat-6 Plenum network cable - 35' (10.7 m) 2
Network Cable Cat-6 Non-Plenum network cable - 6' (1.8 m) 1
Sennheiser Equipment List
Product Description | Quantity
TeamConnect Ceiling 2 | Beamforming Ceiling Microphone array 2
SLCM EB US Ceiling Mic Extension Brackets US 2

Extron Certified DSP Bundle for Zoom Rooms — Extra Large Room Setup Guide ¢ Introduction 1



Additional Required Equipment
Product Description Quantity
ZR Computer Zoom Rooms Computer with Camera and Control 1
interface

Network Switch 10-port PoE network switch 1
Windows® computer Computer MUST contain the following: 1
or laptop e Extron DSP Configurator

e Dante Controller

e Sennheiser TCC2 Control Cockpit

e Extron DSP Configuration *.zip files
NOTE: The Windows computer or laptop is required for adjustments and can be

disconnected after system configuration.

Application Diagrams

The following illustrations are examples of configuring the DMP 128 Plus C V AT for use
with Zoom in a conference room.

SF3CTLP
Sennheiser
TeamConnect
Ceiling 2 Ceiling Mic

SF3CTLP

Display (OFE)

_~ Display PTZ Camera (OFE)
SF3CTLP SE3CTLP //;Emla;()
Sennheiser
TeamConnect
Ceiling 2 Ceiling Mic
Ouny,

SF3CTLP XPA U 1004 SB

DMP 128 Plus CV AT

Display (OFE)

LAN

Zoom Rooms Computer (OFE)

SF3CT LP

Figure 1.
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Figure 2. System Diagram Example

NOTE: The supplied network switch is manageable. However, the default
configuration is sufficient for this solution to function.

Installation Details

Audio Cables

See figure 3 for the connections needed between the DMP Plus and the XPA U amplifier.
Use the supplied balanced audio cable to connect each product.

Tip + Tip + |e—
Ring ) Ring '
Sleeve « Sleeve (s) « ——
Tip *
!

Balanced Output Ring %“ (5 mm) MAX.
DMP Plus 3-pole D t ti
Audio OUTPUT wiring Balanced Dual Mono Input o no_ n
the wires!

Figure 3. Captive Screw Audio Cable Wiring

Speaker Installation
During installation of the /

speakers, please ensure the
rotary tap selector switch is
set to 70V, 16W.

For detailed setup
instructions please see the
SF 3CT LP Setup Guide.

Adjust the Tap Selector
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Configuration

This section provides information on the following topics:
« Configuration Overview

+ Sennheiser TeamConnect Ceiling 2 Setup

+ Dante Controller Setup

o Extron DMP 128 Plus C V AT Setup

o Zoom Rooms Setup

Configuration Overview

1. Unbox and connect the provided hardware using the diagram in figure 2 on page 3.

NOTE: Do not connect the USB cable between the Zoom Rooms (ZR) computer
and Extron DMP Plus. This is connected after the Extron DMP Plus is
completely configured.

2. Configure a computer with the following software utilities:
»  Extron DSP Configurator Software
» Dante Controller Software
e Sennheiser Control Cockpit Software
3. Download the following from the Extron website (www.extron.com/zoom):
o Extron Certified DSP Extra Large Room Bundle .zip folder

Sennheiser TeamConnect Ceiling 2 Setup

Sennheiser TeamConnect Ceiling 2

Sennheiser TeamConnect 2 (TCC2) audio output is connected to the Extron DMP Plus
series via the Dante audio connection.

An additional PoE/Control connection is required to support LED feedback, microphone
mute controls as well as powering the ceiling microphone. Figure 4 shows the browser-
based Control Cockpit interface used to detect and identify the TCC2.

The browser-based Control Cockpit interface detects and identifies the TCC2 using
mDNS when the network cable is attached to the TCC2 Ethernet PoE/Ctrl port.

Figure 4. Control Cockpit Interface

Extron Certified DSP Bundle for Zoom Rooms — Extra Large Room Setup Guide ¢ Configuration 4
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From this interface, the following actions are performed:
o Setting Network Settings
e Beam-steering and Exclusion Zone Adjustments (Optional)

Setting Network Settings
Set and document the address and host name of the device. This is required later.

Figure 5. Control Cockpit Network Interface

Beam-steering and Exclusion Zone Adjustments (Optional)

If additional settings are required to reduce background noise of items such as HVAC,
projector fans, credenzas, etc. the TCC2 has a Priority Zone and up to 5 Exclusions
Zones which can be leveraged to remove these from the microphone pickup.

To configure a zone:

1. Select the desired unit from the Device List. A Properties dialog box is opened.
2. Under the Zones tab, the 3D Overall View shows the real-time focus of the TCC2

automatic beam-steering (see figure 6). Users can manually enable a Priority or
Exclusion Zone.

3. Edit the vertical and horizontal angles of the selected exclusion zones (see figure 7) to
remove the observed noise.

NOTE: Refer to the TeamConnect Ceiling 2 instruction manual for more
information.

Figure 6. Control Cockpit Zones Tab Figure 7. Control Cockpit Exclusion
Zones Adjustment
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Dante Controller Setup

Dante Controller from Audinate is required to route transmitters and receivers, and can be
used to configure Dante settings and monitor performance.

Creating Subscriptions Between Sennheiser TCC2 and Extron
DMP 128 Plus CV AT

1.

Ensure the Laptop, DMP 128 Plus C V AT (Dante), and TCC2 (Dante) are connected
to the same network.

From the Windows Start Menu select: A11 Programs > Audinate > Dante
Controller. The Dante Controller - Network View screen opens. Dante
Controller auto-discovers Dante devices on the network and advertises itself to
allow other Dante-enabled devices to communicate with it. Transmitters connect to
receivers using the subscription matrix.

Figure 8. Routing Tab of Network View Screen

NOTE: The DMP 128 Plus C V AT and TCC2 Dante connections are set to DHCP
by default. If they cannot be discovered, ensure the correct interface is selected
on the PC by selecting Interfaces from the File menu.

Open the Device View of the DMP 128 Plus C V AT by double clicking it in the
Routing tab.

In the Receive tab, rename the two receive channels to TCC2-A and TCC2-B.

Figure 9. Receive Tab of Device View Screen
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5. Inthe Transmit tab, rename the ninth transmit channel to TCC2 Ref.

Figure 10. Transmit Tab of Device View Screen

6. Inthe Device Config tab, rename the DMP 128 P1lus C V AT to the desired name and
click Apply.

Figure 11. Renaming the DMP 128 Plus C V AT

7. From the Device View pulldown, choose the TCC2.
8. Inthe Device Config tab, rename the TCC2 microphones to TCC2-A and TCC2-B.

Figure 12. Renaming the Microphone

9. Close the Device View window and return to the Network View window.

10. To show the transmitters of a Dante device, click the + box next to the desired device
in the Dante Transmitters panel, such as TCC2-A (see figure 13 on page 8).
The + sign changes to a - sign when the device expands.

11. To show the receivers of a Dante device, click the + box next to the desired device in
the Dante Receivers panel, such as DMP128P1usCVAT.

12. Click the intersections of the desired subscriptions between transmitter and receiver
channels.

Extron Certified DSP Bundle for Zoom Rooms — Extra Large Room Setup Guide ¢ Configuration



Figure 13. Network View Routing Screens

NOTES:

e The FarEndOut transmitter channel of the TCC2 device should be routed
to the two receiver channels of the DMP 128 Plus C V AT. A check mark
at the intersection indicates the subscription is made. A check mark also
appears next to the receive channel.

e The TCC2 Ref transmitter channel of the DMP 128 Plus C V AT should be
routed to the AEC Ref receiver channel of the TCC2.
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Extron DMP 128 Plus C V AT Setup

To configure the Extron DMP 128 Plus C V AT, perform these steps:
1. Set IP address via embedded web page.

2. Set the computer or laptop IP address within the range of the product IP address.
The default settings are (LAN for non-V-models, LAN 1 for V-models):

e |P Address: 192.168.254.254
e Subnet: 255.255.255.0
o (Gateway. 0.0.0.0
3. From a web browser, enter the device IP address into the address field.

NOTE: |[f the local system administrators have not changed the IP address, and
the device has not been assignhed an IP address via DHCP, the default address
(LAN for non-V-models, LAN 1 for V-models) is 192.168.254.254.

4. Press Enter.

5. On the login page, enter admin as the Username, enter the Password (if one has
been set), and click Sign In.

o By default, the password is the product serial number

* If mode 5 reset has been performed, then the password is clear and the
Password field can be left blank.

Figure 14. Login Page

6. The Communications Settings panel displays TCP/IP communication settings.
Click Edit to open the Communication Settings dialog box and edit the TCP/IP
settings.

The following can be edited: DHCP status, IP address, subnet mask, and default
gateway. This dialog box also displays the device MAC address. To revert the
computer IP address to a range which can communicate to the new IP address
schema.

NOTE: If DHCP is enabled, IP address, subnet mask, and default gateway
cannot be edited.
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Figure 15. Communications Settings Panel

To push the DSP Template file to the DMP Plus:

1. Open the Extron DSP Template file (downloaded previously in .zip file) with DSP
Configurator software.

2. Connect to a DMP 128 Plus C V AT in Live Mode by clicking the Live button in
the menu bar of DSP Configurator (see figure 16, @). Alternatively, select Tools >
Connect to Device or press <F6> on the keyboard. The Connect to Device dialog
box opens.

Figure 16. Live Button

3. Click the TCP/IP tab in the dialog box.

4. Enter the IP address of the device in the Hostname or IP Address field. If
necessary, enter the device password in the Password field.
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5. When a connection type with a device is established, the Synchronize with Device
dialog box opens. Select Push.

B synchronize with Device = O X

You have elected to change from Emulate mode to live mode. The data in
this configuration must be synchronized with the data in the device. Please
select an option below to continue:

(O Pull data from the device and update this configuration.

Push the data from this configuration to device, overwriting any data
currently in it. The device will disconnect after the push if the
configuration and all the presets are not sent.

Push Configuration
[] Push AT Input Channel Names
Push Presets

@ Al
QO Selected

NOTE: Pushing presets may cause the device to
cycle through each preset that is pushed. This
should not be performed during live operation.

Cance

Figure 17. Synchronize with Device Dialog Screen

6. Click OK.

Once the push is completed, the current state of the connected
DMP 128 Plus C V AT is displayed in the DSP Configurator status panel and the
device is ready for further configuration.

Extron Certified DSP Bundle for Zoom Rooms — Extra Large Room Setup Guide ¢ Configuration 11



USB Naming

The USB Audio tab allows for customizing USB audio interface names and terminal types
(see figure 18). To configure USB Audio settings in DSP Configurator:

NOTE: Extron recommends configuring these settings before connecting USB audio
devices to a PC.

1. From the Tools menu, select Device Settings. The Device Settings dialog box
opens.

Click the USB Audio tab.

In the USB Name field, enter the desired name for the USB Audio interface.

In the USB Terminal Type panel, choose Echo Cancelling Speakerphone.
Click Apply to activate the new settings.

Connect the USB Audio port to the PC.

B pevice Settings ? X

A L I

Unit Info ' IP Settings Passwords ' Serial Settings
Date/Time USB Audio Dante Device

Enter a USB Name for the USB Audio interface.
To restore the default name, clear the field and
click Apply.

USB Name : Extron DMP Plus

USB Name can be up to 32 characters drawn from the
alphabet (A-2), digits (0-9), and special characters
including underscore(_), backslash(\), and spaces.

USB 1 Terminal Type
Appear as:
@ Echo Cancelling Speakerphone

O Speakerphone

0K Cancel

Figure 18. USB Audio Tab
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Edit Macros

Macros are sets of actions that can affect the local DMP 128 Plus C V AT and other
Extron products on the same TCP/IP network. Macros are required for the Mute Sync
Status indicators on the Sennheiser microphone to function properly. They can be
configured in Emulate or Live mode via an Ethernet connection only, and they can be
saved to a configuration file or pushed to DMP 128 Plus C V AT internal memory. Macros
are comprised of up to 32 actions that occur in sequence to quickly configure a system
for specific applications.

Figure 19. Configure Macros Screen

1. Select Add/Edit Remote Destinations (see figure 19, @).
The Add/Edit Remote Destinations dialog opens.

Figure 20. Add/Edit Macro Destinations Dialog Box

2. Select TCC2-A and update the IP address to match the microphone that was
configured earlier.

3. Select Apply.
The Add/Edit Remote Destinations dialog closes.

4. Select Push Macros to Device (see figure 19, @).
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Zoom Rooms Setup

The Extron DMP 128 Plus connects to the Zoom Rooms system from the USB Audio
port. Once the previous steps outlined in this document have been complete, please
connect the Zoom Rooms system to the DMP 128 Plus USB Audio connection via the
provided USB mini-B cable.

The following steps detail the required settings on the Zoom Room device:
1. Select Settings in the Zoom Rooms interface.

Figure 21. Zoom Room Interface Screen

2. Inthe Settings menu, use the menu to select the Extron DMP Plus (or configured
USB Name in above steps) for each of the two parameters: Microphone and
Speaker.

Figure 22. Zoom Rooms Peripherals Dialog Box

NOTE: When using the Extron DMP 128 Plus, Zoom Rooms disables its internal
acoustic echo cancellation (AEC) audio processing so that all audio processing is

completed through the external DSP—the Extron DMP 128 Plus. This provides the
best audio performance.
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Advanced
Settings and
Troubleshooting

This section provides the following topics:
«  DMP Plus Acoustic Echo Cancellation (AEC)
e Technical Support

DMP Plus Acoustic Echo Cancellation (AEC)

AEC Setup Overview

Proper gain structure involves the relationship between the signal at the selected reference
and the signal at the mic input, within the context of proper levels for the reference and
mic inputs independently. The mic input gain setting is naturally optimized for the voice
level of the talker in that room. Therefore, the amount of signal from the far end that is
picked up by the mic is dependent on how much that far end signal is being amplified in
the near end room and the distance from the mic to the speakers.

The reference signal is the signal received from the far end, which arrives at the USB-
assigned Aux Inputs of the DMP Plus. This is sent to the sound reinforcement system
within the near end room, as well as a designated output channel to set the reference
level for the DMP Plus AEC processor.
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AEC Dialog

The AEC dialog in DSP Configurator contains meters and indicator LEDs that are essential
for setting up gain structure and monitoring activity.

O AEC Indicators

® Meters

@© Select Reference

@® Noise Cancellation (on the following page)

@ Advanced AEC Controls (on the following
page)

Figure 23. AEC Controls

O AEC Indicators

e Far - lights when activity is detected from the remote site.

e Near - lights when activity is detected from the local site.

« Update - lights when the AEC is updating, i.e., converging or reconverging.
@ Meters

« ERL - the ratio in dB between the signal at the reference and the signal at the
AEC channel input. When ERL is a positive number, the signal level at the AEC
channel input is lower than the signal at the selected reference.

NOTE: The ideal level range for this
meter is 0 to +15 dB. This ensures the
right amount of reference signal is being
sent through the AEC processor.

e ERLE - the amount in dB of potential echo signal that the AEC algorithm, not
including NLP processing, is cancelling.

e TER —the sum of ERL + ERLE, in dB.
@© Select Reference

The provided configuration includes a selected AEC reference. If necessary, a different
AEC reference can be selected from the drop-down list.
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©® Noise Cancellation (see figure 23 on page 16)

Noise Cancellation may be switched on or off from the AEC dialog. The noise
canceller will detect steady state noise, such as HVAC or other continuous system
noise, and effectively remove it without causing audible artifacts.

@ Advanced AEC Controls
Click on the expand and collapse icon to expose the advanced AEC controls.
Advanced control functionality is as follows:

Technical Support

Non-linear Processing (NLP) Controls:

e Enable NLP — This box is selected by default. Non-linear processing is
necessary for the complete removal of echo.

« NLP Presets — Click a button to load a set of values to the three NLP

parameters. If not using one of these presets, enter values into the fields for

the following three controls:

*  Max NLP Reduction — The maximum possible reduction in echo artifacts that

can be applied.

o Attack Time — The speed in which NLP is applied.

e Release Time — The speed in which NLP is released.

Additional Controls:

* Double Talk Echo Reduction — Sets the amount of echo reduction applied
during double-talk.

o Comfort Noise — Sets a comfort noise level in dB to eliminate states of
complete silence, which may be perceived as a failed connection.

For Extron technical support, visit: www.extron.com/company/contactus.aspx
For Sennheiser technical support, visit: sennheiser.com/service-support
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Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall

deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, Asia: Japan:

and Central America: Extron Asia Pte. Ltd. Extron Japan

Extron 135 Joo Seng Road, #04-01 Kyodo Building, 16 Ichibancho

1230 South Lewis Street PM Industrial Bldg. Chiyoda-ku, Tokyo 102-0082

Anaheim, CA 92805 Singapore 368363 Japan

U.S.A. Singapore

Europe: China: Middle East:

Extron Europe Extron China Extron Middle East

Hanzeboulevard 10 686 Ronghua Road Dubai Airport Free Zone

3825 PH Amersfoort Songjiang District F13, PO Box 293666

The Netherlands Shanghai 201611 Dubai, United Arab Emirates
China

Africa:

Extron South Africa

South Tower

160 Jan Smuts Avenue
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not
authorized by Extron.

NOTE: |If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return
Authorization) number. This will begin the repair process.

USA: 714.491.1500 or 800.633.9876 Asia: 65.6383.4400
Europe: 31.33.453.4040 or 800.3987.6673 Japan: 81.3.3511.7655
Africa: 27.11.447.6162 Middle East: 971.4.299.1800

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage
during shipment. Returned units must include the serial number and a description of the problem, as well as the
name of the person to contact in case there are any questions.

Extron makes no further warranties either expressed or implied with respect to the product and its quality,
performance, merchantability, or fitness for any particular use. In no event will Extron be liable for direct, indirect, or
consequential damages resulting from any defect in this product even if Extron has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may
not apply to you.

Worldwide Headquarters: Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876
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